SPEEDTECH
PUI-2000 Series

Supported version  TOP Design Studio V4.0 or higher {Rl

TOP

J

CONTENTS

We want to thank our customers who use the Touch Operation Panel.

1. System configuration Page 2

Describes the devices required for connection, the setting of

each device, cables, and configurable systems.

2. External device selection Page 3

‘ Select a TOP model and an external device.

3. TOP communication setting Page 4

Describes how to set the TOP communication.

4. External device setting Page 9

Describes how to set up communication for external devices.

5. Cable table Page 10

Describes the cable specifications required for connection.

6. Supported addresses Page 11

Refer to this section to check the addresses which can

communicate with an external device.

External device connection manual for TOP Design Studio 1/ 1



1. System configuration
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The system configuration of TOP and “SPEEDTECH" is as follows:

System setting ‘

Link I/F Communication method
3.1 Settings example 1 5.1. Cable table 1
RS422 P R>232 (Page 4) (Page 11)
ort age age
PUI 2000 Series . -
on CPU unit 3.2 Settings example 2 | 5.2. Cable table 2
RS-422,485
(Page 6) (Page 12)
W Connection configuration
+ 1:1 (one TOP and one external device) connection — configuration which is possible in RS232C/422 communication.
T
- = - - = I'_ .
e ma m il
| |
+ 1:N (one TOP and multiple external devices) connection — configuration which is possible in RS422 communication
ToF
e o e e = - i 2 Ex
B S B oS L o WY assassans e Lt
T
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2. External device selection

W Select a TOP-R model and a port, and then select an external device.

Select Device H
PLC select [COM2]
Filter : |[AII] w Search :

@ Model (O Vendor
Vendor

& Back | B Next X Cancel

Select Device n

PLC Setting[ SPEEDTECH : PUI- 2000 Series ]
Alizs Mame @ |PLCL

Interface : | Computer Link ~

Protocol : |Computer Link ~
String Save Mode : |First LH HL Change

[ use Redundancy

Comm Manual

Primary Option

Timeout msec
Send Wait msec

Retry 5 -

Bus address

CRC 4Byte v

@ Back + OK * Cancel

Settings Contents

TOP-R Model Check the TOP-R display and process to select the touch model.

External device | Vendor Select the vendor of the external device to be connected to TOP-R.
Select “SPEEDTECH".

PLC Select an external device to connect to TOP-R.

Select “"PUI - 2000 Series".

Please check the system configuration in Chapter 1 to see if the external device you want to
connect is a model whose system can be configured.
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3. TOP-R Communication setting
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The communication can be set in TOP Design Studio or TOP-R main menu. The communication should be set in the same way as

that of the external

device.

3.1 Communication setting in TOP Design Studio

(1) Communication interface setting
M [Project > Project Property > TOP Setting] — [Project Option > “Use HMI Setup” Check > Edit > Serial]

— Set the TOP communication interface in TOP-R Design Studio.

Project Option X
-Change HMIHT g Add PLC () ST Change PLCIT) | [ Delete PLEID]
D e Sati:ing PLC Buffer Sync. | Date [ Time Sync.  Screen Option  Unit Convert
- # Option Module Setting Project Option ~ Screen Change | HmiSetup = Global Lock & Touch  Project Style || Splash
.4 FieldBus (0)
e ?'Eivgg;ingg)g Fimi Setup Opten Initialization Edit
v fgW CoM2 () Project Settng P
H -4 PLC1; SPEEDTECH : PUI-2000 Seri HMIDisable=0
8 COM3 (0) Project Name =New project
Ethernet (0) Start Mode=Menu
; Wireless (0) E:;iz:igmm:l
-4 USBDevice (1) Latch Set=0n0
Communication Error Message=0
UsBErrorMessage=0
StorageErrorMessage=1
DatabaseMessage=1
SystemMessage =1
DisplayLockIcon=0
Contral Fanel
System m[)evices :naService =% 0Option
o Serial >
S -y
| . o
I l =~ & Serial Port: @ COMZ v
FLLC SECUrity Dat e/ Time Signal Level
(@ RS-232C (O RS-422(4) O RE-485(2)
Baud Rate: 38400 .
0 0 —
% A eEme | ) .
M & Data Bit: 8 -
Eth 1 Serial HOM | .
e[ MNe erila Stop Blt: .I -
o \ Parity Bit: Mone M
= "\\ Flow: [ff
L_A ® Ping
Diagnost ic File Fing Auto Search Loopback Test
Manager
Apply  Cancel
Items TOP-R External device Remarks
Signal Level (port) RS-232C/RS-485 RS-232C/RS-485
Baud Rate 38400
Data Bit 8
Stop Bit 1
Parity Bit NONE

* The above settings are examples recommended by the company.

Items Description

Signal Level Select the serial communication method between the TOP-R and an external device.

Baud Rate Select the serial communication speed between the TOP-R and an external device.

Data Bit Select the serial communication data bit between the TOP-R and an external device.

Stop Bit Select the serial communication stop bit between the TOP-R and an external device.

Parity Bit Select the serial communication parity bit check method between the TOP-R and an external device.
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(2) Communication option setting

M [ Project > Project Property > Device Setting > COM > "PLC1 : PUI - 2000 Series"]
— Set the options of the SPEEDTECH communication driver in TOP Design Studio.

TOP ooz e
Touch Qperation Panel

Project Option

- Change HMI[H] ' Add PLC[A] | THiTal Change PICIO | 1] Delete PLCID]

r LI TOPSettng PLC Setting[ SPEEDTECH : PUI-2000 Series ]
i L.[3 5YS : TOPRX1500%
W Option Module Setting Alias Mame : |PLC1 |
W FieldBus (0) Interface : | Computer Link ~
8 RFID (0)
Device Setting Protocol : | Computer Link ~ Comm Manual
-~ TgW COM1{(0) String Save Mode : [First LH HL Change
W -l COM2 (1)
| L PLC1: SPEEDTECH : PUL-
=¥ COM3 (0) [ use Redundancy
[ Ethernet (0) AND ~
gl USBDevice (0) _ - =
Primary Option
Timeout 200 &1 | msec
Send Wait msec
Retry 5 z
Bus address
CRC Byte v
< >
Apply Close
Items Settings Remarks
Interface "Computer Link ]
- Fixed
Protocol Computer Link

TimeOut (ms)

Set the time for the TOP-R to wait for a response from an external device.

SendWait (ms)

Set the waiting time between TOP-R's receiving a response from an external device and

sending the next command request.

Retry

Retry attempts upon communication failure.
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3.2. Communication setting in TOP-R
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* This is a setting method when “Use HMI Setup” in the setting items in “3.1 TOP Design Studio” is not checked.

W Touch the top of the TOP-R screen and drag it down. Touch “EXIT" in the pop-up window to go to the main screen.

(1) Communication interface setting

B [Main Screen > Control Panel > Serial]

Conikroll Panel

- ] Serial

i Serial Port: [CUWH "

(i

Ethernet

Serial

Signal Level
() BS-232C O RS-422(4) @ AS-485(2)

Baud Rate: | 36400 -
Data Bit: | 8

Parity Bit: [ Mone

|

|
Stop Bit: | 1 -

|

|

Flow: | (ff

Items

Diagnost ic File
Manager
[System]
TOP-R

Close r

External device

Remarks

Signal Level (port)

RS-232C/RS-485

RS-232C/RS-485

Baud Rate 38400
Data Bit 8
Stop Bit 1
Parity Bit NONE

* The above settings are setting

examples recommended by the company.

Items Description

Signal Level Select the serial communication method between the TOP-R and an external device.

Baud Rate Select the serial communication speed between the TOP-R and an external device.

Data Bit Select the serial communication data bit between the TOP-R and an external device.

Stop Bit Select the serial communication stop bit between the TOP-R and an external device.

Parity Bit Select the serial communication parity bit check method between the TOP-R and an external device.
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(2) Communication option setting

B [Main Screen > Control Panel > PLC]

@ System Driver(COMZ)  PLCI(SPEEDTECH : PUI-2000 Series) -

Interface | Computer Link Rd
Protocol | Computer Link R
Timeout 300 5] msec
YNC Send Wait msec
tierer ||| o | Retry
. - Bus addre

Ethernet

0[5
CRC [ fByte]~]

el

Diagnost ic

Ciagnostic

[System]

o
[ bpp |y HCancell
gl

Items Settings Remarks
Interface “"Computer Link )
Fixed
Protocol Modbus Rtu
TimeOut (ms) Set the time for the TOP-R to wait for a response from an external device.
SendWait (ms) Set the waiting time between TOP-R’s receiving a response from an external device and
sending the next command request.
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3.3 Communication diagnostics

W Diagnosis of whether the port communication is normal or not
- Touch “Communication diagnostics” in [Control Panel > PLC].

- The Diagnostics dialog box pops up on the screen and determines the diagnostic status.

oK Communication setting normal

Time Out Error Communication setting abnormal
- Check the cable, TOP-R, and external device setting status. (Reference: Communication diagnostics
sheet)

B Communication diagnostics sheet

- If there is a problem with the communication connection with an external terminal, please check the settings in the sheet below.

Items Contents Check Remarks
System How to connect the system OK NG ) )
. . - 1. System configuration
configuration Connection cable name OK NG
TOP-R Version information OK NG
Port in use OK NG
Driver name OK NG
Other detailed settings oK NG
Relative prefix Project setting oK NG
Communication 2. External device selection
) ) oK NG L .
diagnostics 3. Communication setting
Serial Parameter Transmission
OK NG
Speed
Data Bit OK NG
Stop Bit oK NG
Parity Bit oK NG
External device CPU name OK NG
Communication port name (module name) OK NG
Protocol (mode) OK NG
Setup Prefix oK NG
Other detailed settings OK NG . .
4. External device setting
Serial Parameter Transmission
OK NG
Speed
Data Bit OK NG
Stop Bit oK NG
Parity Bit oK NG
Check address range 6. Supported addresses
OK NG (For details, please refer to the PLC
vendor's manual.)
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4. External device setting

Configure the communication setting of the external device by referring to its user manual.
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5. Cable table

This chapter introduces a cable diagram for normal communication between the TOP-R and the corresponding device.

(The cable diagrams described in this section may differ from the external device vendor’s recommendations.)

W RS-232C (1:1 connection)

COM PLC
Pin Signal Pin Cable connection Signal
arrangement*Note 1) name number name
1 5 CcDh 1
g S‘ sD 3 RD
Based on DTR 4 T— DTR
communication SG 5 l_ 5G
cable connector DSR 6 DSR
front, RTS 7 E RTS
D-SUB 9 Pin male cTs 8 cTs
(male, convex) 9

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector.

W RS-422 (1:1 connection)

by PLC

Pin Signal Pin Cable connection Signal

arrangement*Note 1) | name number name

1 5 RDA(+) 1 SDA(+)

2 g 3 RDA(+)

Based on RDB() 4 RDB(-)

communication SG 5 SG

cable connector SDA(+) 6
front, 7
D-SUB 9 Pin male 8
(male, convex) SDB(-) 9

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector.

W RS-485 (1:1 connection)

CoOM PLC
Pin Signal Pin Cable connection Signal
arrangement*Note 1) name number name
1 5 RDA(+) 1 SDA(+)
6 5 3 *— RDA+)
Based on RDB() 4 RDB(-)
communication SG 5 SG
cable connector SDA(+) 6 —*
front, 7
D-SUB 9 Pin male 8
(male, convex) SDB(-) 9

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector.
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6. Supported addresses

The devices available in TOP are as follows:
The device range (address) may differ depending on the CPU module series/type. The TOP series supports the maximum address
range used by the external device series. Please refer to each CPU module user manual and be take caution to not deviate from the

address range supported by the device you want to use.

Device Address .
- - Notation Name Remarks
Code | Size Bit Word
I 1687 10.0 - 115.15 WIO — WI15 %d Analog input
A 16817 A0.0 - A7.15 WAO — WA7 %d Analog output
C 1681 C0.0 - C0.15 WCO0 - WCO %d Relay output
M 16si7 MO0.0 — M2047.15 WMO - WM2047 %d Dynamic memory
R 1687 R0.0 - R511.15 WRO - WR511 %d Static memory
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